
ChessKing™ Software version 1.00

Copyright © 1997 by Craig Shoemaker

Make checks payable to Craig Shoemaker.  Mail check or money order drawn on a U.S. 

bank for $40 to

Craig Shoemaker

4014 N. 41st Street

Arlington, VA  22207   U.S.A.

e-mail:  craig.shoemaker@his.com

World Wide Web address is http://www.his.com/~esoteric/

Phone:  (703) 534-5884

You may always check my current address by looking in the Macintosh Product Registry.

Quick Start is given at the end of this file.

ChessKing™ software allows two individuals to play chess together while they share one 

computer and one terminal screen.  Different variations of chess are allowed to be played.

The software is rather primitive at this time.  However, there is never any implied promose 

that I will work on this software or that more features will be added at some future date.

This software is not free.  It costs $40.  See how to make payment above.  If you keep this 

software in your possession either on a floppy or hard drive or stored in any manner then you 

must pay the fee to use this software which is $40.  You may also make installment payments if 

you are short of cash.

This software is sold as is and I am not responsible if anything bad happens for any 

reason.

You cannot sell this product, bundle this products with other products (whether these 

other products are sold or given away) nor imprint this product's image on hard disks or CDs for 

later sale or give-aways without express written permission from Esoteric Software.

You may not distribute this software.

Requirements:  Any Macintosh running System 6.0.8 or higher, including, of course 

System 7.  I do not know if system software earlier than 6.0.8 will work.

If any system requirements are not met you will hopefully be notified in an alert box in the 

program.

Set your monitor depth at 256 colors or 256 grays, if possible.  To set your monitor depth 

to 16 grays is also quite acceptable.  But, any monitor depth including black and white is fine (but 

if you set it to black and white then only open boards that are in black and white).

You can, of course, set your monitor depth to thousands or millions of colors for this is fine 
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also.

If your monitor support only 4 colors and a you can't see the board squares on your 

screen, then try setting your monitor to 4 shades of gray and you should then be able to see the 

black and white playing squares on the board.

There's no doubt that the chess board and pieces look great when you have Color 

Quickdraw.  But if you don't have Color Quickdraw (because your computer is too old and 

doesn't support colors (that is, it is a 68000 processor and not a 68020 processor or later), then 

although the display isn't cool looking, it will allow you to play.  If you don't have Color Quickdraw 

and you choose the "Shrink" button, the display of the chessmen on the chess board is almost 

unreadable.

This program should run on any Macintosh from the oldest MacPlus to the newest Power 

Macs.

Here are some rules of chess that ChessKing does not yet deal with in one way or 

another.  When (and if) ChessKing has a rudimentary thinking apparatus then some of these 

rules will be checked for and announced.

Checkmate Rule

ChessKing does not yet check to see if any side is checkmated.  Indirectly it can be said 

that ChessKing checks for mate in that if a side is checkmated and tries to move, ChessKing will 

say that the move so made is illegal.  But, ChessKing does not announce that one side or the 

other has checkmated the opponent.

Stalemate Rule

If a King is not in check and the only moves his side can make will place him in check, the 

game is stalemated.  Again, ChessKing does not announce stalemate, but if a side is in 

stalemate and tries to move ChessKing will inform that player that he has made an illegal move.  

A stalemate is a drawn game in which no side wins.

Lack of Adequate Force to Checkmate

This is a drawn game.  ChessKing does not check for this yet (and, of course, does not 

announce it since it doesn't check).  Lack of adequate force to checkmate is a drawn game with 

neither side being victorious.

Drawn by Agreement
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ChessKing can't think of a move to play much less decide if it is time to either accept or 

offer a draw.  Furthermore, ChessKing would need some information about the opponent's 

strength before making any such decision (assuming ChessKing could think).

Draw by Repetition

This is a tricky rule and as written in Reinfeld's The Complete Chessplayer:  "Here the rule 

states that where a position has already turned up twice in a game, with the same player on the 

move in each case, he may claim a draw before  making the move which will produce the 

position a third time."

Assuming ChessKing had a brain, he is, of course, under no obligation to claim a draw by 

repetition.  Similarly, neither would a human opponent be under such an obligation.  In any case, 

ChessKing doesn't check to see if it is possible to claim a draw by either side based on the draw 

by repetition rule.

The Fifty Move Rule

Here is the rule explained by Reinfeld in his The Complete Chessplayer:  "The so-called 

"50-move rule" specifies that either player may claim a draw if no capture has been made, and 

no Pawn has moved, in the past 50 moves.  Such claims are of rare occurrence, the chief 

purpose of the rule being to penalize bunglers or those who insist on playing on in positions 

which can only be won by a gross blunder on the part of their adversary."

Since computers don't get impatient, there would be no reason for ChessKing to be 

motivated to claim a draw based on the 50 move rule if he is playing an opponent who is hoping 

for a blunder in an obviously drawn position.  ChessKing, of course, when and if he ever thinks, 

should check to see if the 50-move rule is satisfied and be aware that either side could legally 

enforce that a draw be had, but this is not done yet.

Here is the 50-move rule explained by Edward Lasker in his book, Modern Chess 

Strategy:  "Finally, a game is considered a draw when 50 moves have been made without 

accomplishing a checkmate, provided no man has been captured and no Pawn has moved.  

Excepted from this rule are positions in which it can be proved that a mate would require more 

than 50 moves."

Again, ChessKing doesn't at this time check to see if the 50-move rule boundary has been 

breached.  Furthermore, there is at this time no mechanism (such as a dialog box) to allow the 

human playing the computer to tell the computer that he can or cannot demonstrate that a 

checkmate will take longer than 50 moves.
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New Pieces

Depending on what type of chess game you play, you may find new pieces that you are 

not sure how to move.  Don't worry, the game of chess has exactly the same rules, but 

sometimes additional pieces are added (and, of course, if you make an illegal move, ChessKing 

will let you know).

the Jester 
At this time it looks like a jack in a Macintosh box.  It moves like a Knight or a Bishop.  The 

jester at first might remind you of a Bishop, which is good since it moves like a Bishop.  The 

name "jester" or trick player might remind you that it moves like a piece you don't expect:  the 

Knight.  This compound movement is, of course, nothing new, since the Queen moves like a 

Bishop or a Rook.

the Archer 
It looks like a bow and arrow on top of a structure.  It moves like a Knight or a Rook.  The 

bow and arrow suggests "up and over" or a hopping move for the Archer moves like a Knight.  

The structure suggests a sturdy foundation like is found in the Rook icon:  the Archer also moves 

like a Rook.  This compound movement is, of course, nothing new, since the Queen moves like a 

Bishop or a Rook.

the Catapult   

The following diagram shows how the catapult moves.  The catapult can never change 

the color of the squares it hops to.

Printed , This being Page 4



The diagram below shows a possible change in the catapults movement which I may 

make at some future date.

Here the catapult has two types of moves:  a hopping move and a horizontal or vertical 

move by one square (this latter move allows it to change colors and because it cannot move 
Printed , This being Page 5



diagonally, it can be attacked along its forward diagonal by an enemy pawn just as a knight can 

be so attacked).

The catapul hops in two was:  1) it hops three squares vertically (up or down) and then 

breaks one square horizontally (either right or left) or 2) it hops three squares horizontally (right 

or left) and then breaks one square vertically (either up or down).  The catapult never changes 

colors when it hops.

The catapult can only change its color when it moves one square either horizontally or 

vertically.  A catapult is extremely dangerous:  for instance, it can hop to some square where it 

attacks near some square of interest;  then, and this is the danger, it can gently nudge forward or 

sideways or in some combination to bear dangerously down upon a certain square!  A normal 

knight has to hop and hop around to get in position, but a catapult can hop to the general area 

and then move vertically or horizontally one square at a time to fine tune its position;  it is, then, 

extremely powerful.

The above diagram shows the hopping move of the catapult.  It also moves one square 

either vertically or horizontally if it decides not to hop.  The catapult, I think, will probably be a 

very powerful piece;  its strength will be to capture important pieces which are hemmed in and 

can't move to safety.

The following diagram shows another version of the catapult, a version which I don't like 

and which I will probably never implement.

Send me your comments concerning the movements and possible movements given the 

catapult.
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About ChessKing and Computer Brains

ChessKing™ software does not have a brain.  If you would like to write a brain for this 

software please let me know.

If you sell a chess playing brain, let me know your pricing.

Thanks!

Some menus are not implemented.  While other menus are implemented only in part.  

There is never any implied promise that a component that is not implemented now may be 

implemented in the future.  Only time and money will tell how my resources are allocated.

The File Menu

New

Creates a new document.  All documents are text files at this time.

New Game

Creates a new chess game window with a chess board size of 8x8 squares.  Whenever 

you create a new game, you are asked to open the appropriate chess board.  Thus, look for the 

boards in the resource folder having the appropriate size:  8x8 in this case.

New Game 10x8

New Game 10x10

New Capa 10x8 Jester Beds Queen

New Capa 10x8 Jester Entertains King

New Capa 10x10 Jester Beds Queen

New Capa 10x10 Jester Entertains King

New Game 12x8

New Game 12x10

New Game 12x12

Open...

Opens a document.

Open Game...

Not implemented.  Remember that there is never an implied promise that items not 

implemented will be in the future;  they may or may not be, depending on time and money.

Resume Adjourned Game...

Not implemented.

Printed , This being Page 7



Import Game...

Not implemented.

Close Document or Close Chess Game

Close document closes the active document window.  Close chess game closes the 

active chess game window.

Save

Saves a document to disk.

Save As...

Saves a document to disk and you specify the filename.

Save Game

Not implemented.

Save Game As...

Not implemented.

Adjourn Game

Not implemented.

Adjourn Game As...

Not implemented.

Export Game...

Not implemented.

Revert to Saved...

Revert to the last saved version of the document.  All current changes to the document 

you have just made will be lost.

Revert to Saved Game...

Not implemented

Insert New Chess Board...

Not implemented

Insert New Chess Pieces...

Allows you to choose the chess pieces that will be displayed.

Insert Text File...

Insert a text file into the currently selected document where the cursor is.

Insert Game...

Not implemented.

Batch File Translation...

You are not to use this at this time.  It probably works, but I have not even begun simple 

tests of it.  What you should always do:  press “cancel” as soon as you see it.

Page Set Up...
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Prepares a document for printing.  Chess game windows cannot be printed (yet).

Print...

Prints a document.  Chess game windows cannot be printed (yet).

Quit

Quit the application ChessKing™.

The Edit Menu

Undo or Undo Typing or Undo (whatever)

Operates at this time only for a standard document window and not for a graphic chess 

game window.

Cut

Cuts text from a standard document window.

Copy

Copy text from a standard document window.

Paste

Paste text from a standard document window.

Clear

Clear text from a standard document window.

Clear All But Selection

Clear all but selected text from a document window.

Select All

Select all text from a standard document window.

Preferences...

Not implemented.

Letter Format...

Not implemented.

Courier 7

These are fonts and sizes to be used for all standard document windows.  Of course you 

may always select the contents of a document window, copy it, and paste it to a more advanced 

word processor.

Courier 9

Courier 10

Courier 12

Chicago 12

Geneva 10
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Monaco 9

Monaco 10

New York 12

Times 14

The Board Menu

Invert Board

Not implemented.

Board Setup

Not implemented.

The Time Menu

Information...

Not implemented.

The Players Menu

Switch Sides

Not implemented.

Move, if possible, then Switch Sides

Not implemented.

Human is White

Not implemented.

Human is Black.

Not implemented.

The Thinking Menu

Move Now if Possible

Not implemented.

Stop Thinking

Not implemented.
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Start Thinking

Not implemented.

Suspend Thinking

Not implemented.

Resume Thinking

Not implemented.

Think in Slow Motion

Not implemented.

The Brain Menu
Not implemented.

1794340 or whatever number your program shows in the menu

The number of free bytes of memory available to the application.  In this example, 

1794340 / 1024 is 1752k bytes of free memory.

Reminder:  although you see lots of menu items listed above, there is never an implied 

promise that these will ever be implemented.  At this stage, ChessKing™ software is only used 

to allow two people to play different varieties of chess together at one computer on one terminal 

screen.

How to Use ChessKing™ Software

Choose New Game or a chess variant of a new game from the File menu.  Select the type 

of chess board you wish to use:  that is, open the appropriate file containing the picture of the 

chess board.

Choose Show Move List from the Windows menu.  This window will display each move as 

it is made.  This window is a text document file.  You may save it or you may print it.  You may 

also select its contents, copy it and then paste it into another word processor document.  This 

text file contains the computer notation for the moves played.

If you have more than one chess game in action, then first choose the chess game 

window from the Thinking menu, then choose Show Move List from the Windows menu.
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